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Introduction 

SureSync is a powerful file replication & synchronization utility which can be used to ensure users 
on your network are always working off of the most recent version of critical files, for disaster 
recovery purposes, software distribution, and much more. 
 
This evaluator’s guide is designed to walk you through the initial setup of the SureSync product. 
The base SureSync product can perform one-way and multi-way synchronizations via UNC path 
or drive mappings. These synchronization jobs can then be run manually or on a scheduled 
basis. By reviewing this guide, you will become familiar with how to utilize SureSync to implement 
an efficient and powerful synchronization / replication infrastructure in your network. 

System Requirements 

 SureSync’s basic operating system and hardware requirements are: 
 

 Supported Operating Systems: Windows Server 2008 R2; Windows Server 2008; 
Windows Server 2003; Windows Server 2003 R2; Windows Vista; Windows XP; 
Windows 7 

 Processor: 400Mhz Pentium Processor or equivalent (Minimum); 1Ghz Pentium 
Processor or equivalent (Recommended) 

 RAM (total for system): 256MB (Minimum); 1GB (Recommended) 
 Hard Disk: 30MB for application files; 20MB+ for database 
 Display: 800x600, 256 colors (Minimum); 1024x768 high color, 32-bit (Recommended) 

 
SureSync can synchronize data to machines running operating systems such as Windows 95, 
Windows 98, Windows NT 4.0, Windows 2000 and non-Windows machines such as Macintosh 
and Linux machines via UNC path, but the software itself must be installed on one of the 
supported operating systems listed above. 
 
SureSync requires a database which is used to store configuration information. The following 
formats are supported: 
 

 Microsoft Access (default) 
 MSDE 2000 / SQL Express 2005 / SQL Express 2008 
 SQL Server 2000 / SQL Server 2005 / SQL Server 2008 

 
To achieve optimal performance, a SQL database is strongly recommended for setups using 
multi-directional Rule types, environments with more than 50 Relations defined, or environments 
where hundreds of thousands of files will be processed. 
 
SureSync requires a number of Microsoft components to be installed on the system. The 
SureSync installer will inspect your system for these components and offer to upgrade or install 
them as needed. 
 
 Microsoft .NET Framework 3.5 with Service Pack 1 
 Microsoft MDAC 2.8 Refresh with Service Pack 1 
 Microsoft Visual C++ Runtime 9.0 with Service Pack 1 
 Microsoft Windows Installer 3.1 
 Microsoft XML Parser 6.0 
 Microsoft Jet 4.0 with Service Pack 8 
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Contact Information 

If you need further information about SureSync or need clarification on anything within this guide, 
please contact our support group and they will be happy to assist you with your evaluation. 
 
Software Pursuits, Inc. 
1900 South Norfolk Street, Suite 330 
San Mateo, CA 94403 
 
Phone: +1-650-372-0900 
Fax: +1-650-372-2912 
 
Sales e-mail: sales@softwarepursuits.com 
Support e-mail: support@softwarepursuits.com 
 
Technical support is available between 8:00AM and 5:00PM PST Monday through Friday. 

SureSync Add-On Licenses 

A number of Add-On licenses are available for SureSync which enhance the capabilities and 
performance of the software. The available Add-On licenses include:  

SPIAgent Add-On 

 
Ensure high availability and improved replication performance with SureSync's SPIAgent Add-On. 
SPIAgent provides the technology to perform real-time replication and more. Below is a list of 
features that are included when you license the SPIAgent Add-On. 
 

 Real-Time Monitors 
Real-Time replication increases data availability by continuously monitoring data for 
updates. By copying files immediately after they change, SureSync can avoid folder 
scans that are necessary for scheduled jobs.  

 Adaptive Delta Technology 
SureSync copies only the changes made to a file, reducing synchronization time and 
decreasing the consumption of network resources. 

o Delta Processing to Non-Windows Machines 
If you map a non-Windows drive to a drive letter on a Windows machine you can 
process delta copies to that non-Windows machine. This in turn provides 
bandwidth savings between any machines, regardless of the OS.  

 File Compression 
Transmit files in a smaller package across your network by compressing them. File 
compression is particularly useful on slow network connections. SureSync also allows 
you to specify the level of compression to control the impact on your system.  

 TCP/IP Transmissions 
Transmissions across the Internet give you more options on how you connect to remote 
machines. Now it is even easier to keep office branches connected to the information 
they need.  

 Encryption 
Ensure your files are being transmitted securely by utilizing the option to encrypt each file 
transmission. This is an especially useful and necessary tool when transmitting sensitive 
data across the Internet. 

 Change Journal Support for Schedules 
When a Schedule is configured to run a Relation using the SPIAgent Add-On, SureSync 
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utilizes the NTFS Change Journal, which minimizes the amount of scanning a 
synchronization job must perform. Eliminating much of the scanning creates a significant 
performance improvement for Schedules. 

 
Please consult the SureSync with SPIAgent Add-On Evaluator’s Guide for further details. 

SPIAgent File Locking Add-On 

 
The SPIAgent File Locking Add-On requires the SPIAgent to be licensed and in turn gives you an 
additional benefit in file sharing environments. The SPIAgent File Locking Add-On eliminates the 
possibility that a file could be changed on multiple sides of a synchronization resulting in a more 
efficient synchronization with zero risk of lost changes. A user who attempts to open a file that is 
already in use will receive an indication from the application that the file is locked. 
 
Please consult the SureSync with SPIAgent File Locking Add-On Evaluator’s Guide for further 
details. 

ArchiveSync Add-On 

 
SureSync’s ArchiveSync Add-On allows users to create versioned backup copies of files, 
providing an efficient disk-to-disk backup solution. Versioned file copies allow users to quickly 
restore files to a specified point-in-time, without sifting through tape backups. Additionally, when 
archiving or restoring, the ArchiveSync Add-On will allow you to backup and restore security 
privileges as well. 
 
Archiving can be done in real-time to continuously protect data, effectively eliminating tight 
backup windows during the evening. ArchiveSync will also automatically thin out your archive to 
clean storage up. 
 
Please consult the SureSync with ArchiveSync Add-On Evaluator’s Guide for further details. 

Our Scenario 

This guide will walk you through the configuration of SureSync to accomplish a one-way 
distribution of files from a source server named 9PGGCG1-JeffK to two destination servers 
named NETTEST and WINDOWS2008TEST. 
 
In this scenario, SureSync will be used to mirror data from a staging server to two destination 
production machines. This is a common scenario for tasks such as web site publishing, updating 
templates or distributing application updates. 
 
In this example, a folder C:\Web will be mirrored from 9PGGCG1-JeffK to the \\NETTEST\Web 
and \\WINDOWS2008TEST\Web shares on a scheduled basis. 
 

This guide will show you how to configure a one-way synchronization job 
using a Schedule to run the job on a clock basis. In this example, the job 
will run once an hour. SureSync also has the capability to run in real-
time. When run in this mode, changes are synchronized as they occur. 
This functionality requires the SPIAgent Add-On license. Please consult 
the SureSync with the SPIAgent Add-On Evaluator’s Guide for further 
details about configuring a Real-Time scenario. 
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Installation 

To begin your SureSync trial, you must install the correct SureSync components on the right 
machines. SureSync is installed using a Windows Installer (MSI) driven installation application. 
SureSync and all Add-On products are installed using the same installer. 
 
For this scenario, the full SureSync application will be installed on one machine (9PGGCG1-
JeffK). No software needs to be installed on the remote machines when performing a UNC or 
drive mapping based synchronization/replication. 
 

 
 
On the 9PGGCG1-JeffK machine, we will run SureSyncSetup.exe and select SureSync as the 
installation type in the installer. This will install the complete SureSync application and designate 
9PGGCG1-JeffK as the machine where we configure and run our synchronization job. 
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Launch SureSync for the First Time 

Now that the required components have been installed, we can continue with the configuration. 
To launch SureSync for the first time, go to the Start menu, select the SureSync folder and click 
on the SureSync icon. This will launch the SureSync desktop application where you will perform 
your entire synchronization job configuration. On the first launch of the application, SureSync will 
create an Access database to store your configuration information. 
 

The default database format for SureSync is Microsoft Access. 
SureSync also supports Microsoft SQL and this database format is 
recommended for environments running many multi-way Rules or a 
large number of jobs to achieve optimal performance. Please refer to the 
Upgrading from an Access to SQL Database knowledge base topic for 
more information. 

 
Once the database has been created and the SureSync desktop has loaded, you can proceed 
forward with your configuration. 

Installing the SureSync Scheduler 

The SureSync Scheduler is a Windows service that runs on the main SureSync machine. This 
service is responsible for launching Schedules at the correct times and for running Real-Time 
Monitors. You must have a Scheduler running in order for your Schedule to execute at the 
configured time. 
 
To install the SureSync Scheduler service, go to the Tools menu within SureSync and select 
“Schedulers…,” which will launch a window like the one below. 
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To install the Scheduler, click the “Install” button, which will launch a window like the one below. 
 

 
 
Enter the username formatted as machinename\username or domainname\username. This 
account must be an administrator on the machine. Click “OK” to install the service. 
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Once the service has been installed, click on the machine name and click “Start.” The Scheduler 
will now be listed as Machine Name (Running). 

Creating the Relation 

Relations are the basic building blocks of the SureSync application. Each Relation contains the 
root paths (source and destination paths) that apply to that Relation and options for the Relation. 
Each Relation also contains one or more Rules, which tell SureSync how to replicate & 
synchronize data. The Relation and the Rule are created together in one wizard. 
 

The wizards are designed to quickly and easily configure the basic 
options needed to get a Relation up and running. SureSync is an 
extremely flexible product with many advanced options. Additional 
options can be specified on the properties panels for the Relation after it 
has been created. 

 
To create your Relation, launch SureSync and then go to the "File" menu, select "New" and then 
select "Relation." 
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Name Your Relation 

 

 
 
The first panel in the wizard allows you to name your Relation. Enter the name of the Relation 
and an optional description and click “Next” to continue. The Relation name used for this example 
will be “Publish Web Data.”  

Specifying Root Paths 

 
The next panel is used to specify the source and destination root paths that you want to 
synchronize. Later in the wizard you will specify which path is the source and which is the 
destination. In this dialog box, you are simply listing the source and destination paths that will be 
part of this synchronization. 
 

There must be at least two root paths specified (a source and a 
destination) to have all Rule types available. Later on in the wizard you 
will get to specify which path is the source and which is the destination. 
If you specify only one path then the only Rule methods available later in 
the wizard will be “Delete” and “Skip”. 

 
Root paths are added by clicking the “Add” button at the bottom of the panel to display the “Select 
a new root path” panel shown below. 
 
For this example, our root paths are:  
 

 C:\Web on 9PGGCG1-JeffK 
 \\NETTEST\Web on NETTEST 
 \\WINDOWS2008TEST\Web on WINDOWS2008TEST 

 
First, we will select the local path on 9PGGCG1-JeffK by browsing to that path through “My 
Computer,” highlighting the directory and clicking “OK.” 
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Once that path has been added, we must add the paths on the remote machines. Click the “Add” 
button again to add a new path. Then you can browse through “Network” to the remote machine 
and select the share, select the drive letter if using a drive mapping, or manually type the path 
into the “Root Folder” field. In this case, we have used the browse panel to select the UNC path. 
 

 
 
Click “OK” to add the path. Continue clicking “New” and adding paths until all the paths involved 
in the synchronization are present. 
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Once all of the paths have been entered, press the “Next” button to continue. 

Determining the Best Rule 

 
SureSync offers a number of different replication & synchronization methods, allowing a great 
deal of flexibility in how your data is handled. A chart detailing each of these Rules can be found 
in the help file under “Rule Methods Summary.” 

Selecting Your Rule 

 
On this next panel we will specify the Rule to use for this job. 
 

If the panel indicates that only the "Delete" and "Skip" Rules are 
available, you have selected only one root path. You should use the 
"Back" button to return to the root path entry panel and add your other 
root path(s). 

 
The type of Rule we will be using in this example is “Mirror." Click on the Rule you wish to use. 
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Click the "Next" button to continue.  

Selecting Source and Destination 

 
The next panel is where you indicate which root path is to be used as a source and which path(s) 
are destinations. In this example job, the source path is the C:\Web folder on 9PGGCG1-JEFFK. 
 
Your wizard panel should look like the one below:  
 

 
 
Click the “Next” button to continue. 

Filtering Subfolders 

 
The next panel in the wizard allows you to include or exclude specific subfolders. The default “\” 
means to include all subfolders. You can enter subfolders into the text field or select them using 
the checkboxes in the browse dialog on the lower portion of the wizard panel. Folders are 
excluded by placing a minus character (-) in front of the folder name. Multiple folder entries are 
separated by the vertical bar character (|). 
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Examples 
 
To synchronize only two subfolders named “FolderA” and “FolderB,” you would enter the 
following: 
 
\FolderA\ | \FolderB\ 
 
To synchronize all subdirectories except for subfolders “FolderA” and “FolderB,” you would enter 
the following:  
 
\ | -\FolderA\ | -\FolderB\ 
 
For our example scenario, the default “\” option will be used to process all subfolders. 
 
To learn more about how to include and exclude subfolders, press the “F1” key on this panel.  
 
Click the “Next” button to continue. 

Filtering Based on File Masks 

 
The next panel displayed will let you indicate the files to be included or excluded from the job. 
Each entry in this panel should be separated by a vertical bar (|) character. To exclude a file 
name or file type, place a minus sign (-) in front of the mask. 
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Examples 
 
To synchronize only *.doc files and a file named “Test.txt,” you would enter the following: 
 
*.doc | Test.txt 
 
To exclude *.tmp files, *.doc files, and a file named “Test.txt,” you would enter the following: 
 
-*.tmp | -*.doc | -Test.txt 
 
The default setting for this panel is *.* | -*.tmp | -~*.doc | -~$.doc? | -~$.xls?. This tells SureSync 
to synchronize all files except *.tmp files and some commonly used Microsoft Office programs 
temporary files. This is the setting we will use for this example. 
 
To learn more about how to include and exclude files based on file masks, press the “F1” key on 
this panel.  
 
Clicking the “Finish” button will create your Relation. The Relation Wizard only displays a subset 
of essential options for a Relation. There are many other options which can be configured by 
modifying the properties of the Relation using the SureSync Desktop. Pressing the “F1” key on 
any tab in the application will display context sensitive help detailing the options on that tab. 

Previewing Your Relation 

 
Once the Relation has been created SureSync will prompt you to preview the newly created 
Relation. The preview displays the actions that SureSync would perform without actually 
executing them. This is a great way to determine if your Relation will perform as expected. You 
should always preview a Relation after making changes. 
 
When prompted to preview, click on the "Yes" button. 
 
There are different displays available for the preview by selecting options under the "View" menu. 
Please consult the SureSync Help File for more information about the preview window. 
 
You may browse through the folders in this window and see how your files are affected. A legend 
can be accessed from the “Help” menu by selecting “Legend.” This will detail what the various 
preview icons mean. 
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When you are done with the preview, close the preview window. This will perform no action. You 
can also click the “Run” button to run from the Preview.  

Creating a Schedule 

A Schedule is used to run a Relation or set of Relations on a clock/calendar basis. For example, 
you could run the Schedule once every hour, once a day, or once a week.  
 

A Relation can only be active once at a given time. If you’re planning to 
run a Relation with a Schedule you should not attempt to run the same 
Relation with a Real-Time Monitor. If you already are running a Relation 
in a Real-Time Monitor it cannot be run in a Schedule until the Real-
Time Monitor is placed on hold and stopped. 

 
To begin configuring your Schedule go to the File menu, select “New”, and then “Schedule.”  
 

The wizards are designed to quickly and easily configure the basic 
options needed to get a Schedule up and running. SureSync is an 
extremely flexible product with many advanced options. Additional 
options can be specified on the properties panels for the Schedule after 
it has been created. 

Name Your Schedule 

 

 
 
The first panel allows you to name your Schedule. Enter the name of the Schedule and an 
optional description. Then click “Next” to continue. 

Selecting What Relation(s) to Run 

 
The next panel is where you specify which Relation(s) you would like this Schedule to run. 
Specify these Relations by checking the box next to their name(s).  
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You can run multiple Relations under one Schedule. When doing so, the Relations are run in the 
order listed on this panel. To adjust the order, simply select a Relation and press the up or down 
arrows on the right side of the panel. 
 

 
 
Click the “Next” button to continue. 

Select the Schedule Type 

 
The next panel of the Schedule wizard determines the Schedule type. You can choose to create 
a Schedule that runs only once at a set time, or you can select a Schedule that runs multiple 
times. For this example, we will select “Schedule this job to run multiple times.” 
 

 
 
Click the “Next” button to continue. 
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Select the Schedule Frequency 

 
The next panel of the Schedule wizard determines the Schedule frequency. You can select to 
create a Schedule that runs every day, or that runs based on things such as Days of the Week, 
Weeks of Each Month and more. For this example, we will select “Every Day.” 
 

 
 
Click the “Next” button to continue. 

Configure Schedule Repeat Settings 

 
The next panel of the Schedule wizard determines how frequently the Schedule repeats. For our 
example, we want the Schedule to run every hour. To configure this, check “Run Schedule 
multiple times each day” and set “Time between each execution” (hours:minutes) to 01:00. 
 

 
 
Click the “Next” button to continue. 
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Select the Schedule Run Date 

 
The next panel of the Schedule wizard determines when the Schedule will be run the first time. 
For this example, we will use the default setting. 
 

 
 
Click the “Finish” button to create the Schedule with the selected settings. 

Modifying and Running Your Schedule 

 
When the wizard is complete you will be returned to the SureSync desktop and the Schedule you 
created will be displayed.  
 
You can make changes to the options for your Schedule in the main SureSync window by first 
clicking on the Schedule you wish to modify. You can then look through the tabs on the right side 
for options to change. Pressing “F1” while on any tab will bring up context sensitive help 
describing the options in detail.  
 
The Schedule will automatically run at the time you selected during the wizard. 

Configuring E-mail Alerts 

E-mail alerts can be a useful way of notifying the SureSync administrator of a problem which 
should be investigated. 

Configuring a SMTP Profile 

 
To start the configuration of alerts, you must launch the SPIAgent Configuration utility and create 
a SMTP profile. The SMTP profile provides SureSync with the necessary details about your 
SMTP e-mail server so the program can send messages to you. 
 
To launch the SPIAgent Configuration utility, open SureSync, go to the “Tools” menu and select 
“Alert user list…” 
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To create a SMTP Profile, go to the SMTP Profiles menu and select “Add New SMTP Profile…” 
 

 
 
The “Add SMTP Profile” panel allows you to define the SMTP settings for your mail server. The 
following fields must be configured: 
 

 Profile Name: The name of the profile that you are configuring. For example, you might 
use the name of the SMTP server.  

 SMTP Server: The server address of the SMTP server. For example, smtp.mail.com.  
 SMTP Port: The SMTP port for the SMTP server. The default SMTP port is 25.  
 Sender Name: The name that will appear in the From: field of messages sent by 

SureSync.  
 Sender Address: The e-mail address that will appear on messages sent by SureSync.  
 Reply Address: The reply address that will appear on messages sent by SureSync.  

 
You can also define SMTP Server Authentication settings if your SMTP server requires a valid 
logon to send messages (most do). The following fields can optionally be configured: 
 

 User Name: The username that SureSync will log into this SMTP server with when 
sending an e-mail alert.  

 Password: The password for the username defined in "User Name" should be entered 
here.  

 Confirm Password: The password for the username defined in "User Name" should be 
confirmed here.  
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Click “OK” to create the SMTP Profile. Clicking on the SMTP Profile tab of the SPIAlert 
Configuration Utility will show the new profile. 
 

 

Configuring an Alert User 

 
The second part of configuring E-mail Alerts is to define an Alert User. The Alert User defines the 
e-mail address(s) that will be sent messages when errors occur. To configure an Alert User, click 
on the “Alert Users” menu and select “Add User…” 
 

 
 
The “Add User to Alert” field has the following fields to be configured: 
  

 User Name: The username that will be used in SureSync to represent this e-mail 
address.  

 E-mail Address: The e-mail address that SureSync will send the alert messages to.  
 Mail Profile Name: The SMTP profile that will be used to send the message.  

 
Multiple e-mail addresses can be added by separating the addresses 
with commas (,) or semi-colons (;). This allows you to easily send 
messages to a group of SureSync administrators. 

Configuring the Schedule to Send Alerts 

 
The final step of the alerts configuration is to tell the Schedule to use the Alert User, and at what 
level of errors to send alerts. This is accomplished by clicking on the Schedule in the SureSync 
desktop, clicking on the Alerts tab, selecting the Alert User from the drop-down menu and then 
clicking “Apply.” 
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Additional details about the E-mail Alert levels available can be found by pressing “F1” while on 
the Alerts tab. 

Monitoring the Synchronization 

Monitoring your synchronization job is important, and SureSync makes this process easy through 
the use of two different status panels. 

Detailed Status 

 
The detailed status panel will show you file level activity for a current job as well as common 
counters such as files added and files deleted. If you want to take an in-depth look at a particular 
job, you will want to use Detailed Status. 
 
To launch Detailed Status, right click on the job and select “Job Status.” You can also select the 
job, go to the “View” menu and select “View Job Status.” 
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Enterprise Status 

 
The Enterprise Status panel can be used to view the current status of jobs from SureSync 
installations anywhere on your network. To see detailed status, you can launch the Detailed 
Status panel for a particular job right from the Enterprise Status application. The Enterprise 
Status panel provides an easy way to stay current on the status of your jobs, no matter where 
they are running. 
 
Enterprise Status can be launched by going to the Start menu, selecting SureSync and then 
“SureSync Enterprise Status.” You can also click on the “View” menu and select “Enterprise 
Status,” or click on the “Enterprise Status” button in the menu bar. 
 

 
 


